The Nios Il Embedded “Hello World” Lab:
For The MAX 10 Development Kit

March 2016

Version 1.5



Revision History

1.0 5/1/2015 L. Landis Initial Release

1.1 6/2/2015 L. Landis Added BeMicro

1.2 11/30/2015 I. Rush Added CVE DevKit

1.3 12/2/2015 S Meer Consolidated Sections
1.4 12/4/2015 [.Rush Updated Pinout Table
1.5 3/17/2016 K. Kita Separated Lab by Board




Contents

OVEIVIBW ..ttt ettt ettt s et e s b et e s s b e e e s s s b e e e s s b e e e s s b ba e e s s asbaeessanbaeesenraeas 3
1] o I\ o =T PP U ST PPTOPPTI 4
QUATLUS INSTAIATION L.eiieiiiiie et ettt et e s bt e e sab e e s bt e s beeesabee e beeesabeesseeesareeanns 4
LTy P~ T =l o 1Y PP 5
Objective of hardware design for the “Hello World” 1ab...........ooo i 6
HARDW ARE DESIGN ...ttt ettt ettt she e sttt et e be e s bt e saeesae e st e et e e bt e beesbeesaeesaseeateebeenseesanenas 7
Fa T LA BT <] AU 1SR 7
Get Started With QUAITUS .....cooeeieeee ettt e sab e e st e s bt e e sabee e seeesateesbeeesareenane 9
Building your Qsys based proCeSSOr SYSTEIM ....iiiuiiiiiiiiieeeiireeeeiiteeeessree e e ssre e e sssrbeesesabeeesssabeeeessbeeessnnsenas 12
BUIlAING the top [@VElI AESIZN..cciieiiie et e e e st e e e s bbe e e s s sabee e e ssbeeessnreeas 24
Adding the Nios Il system iNtO YOUI dESIZN ....cc.uuiiiiiiiiie ettt e e et e e e eear e e e e be e e e e anaeeeens 30
Adjusting

SOFTWARE DESIGN ...ttt ettt ettt sttt et e bt e bt e sbeesatesat e e bt et e e beesbeesaeeeateebeenbeesbeesneenas 33
Creating the Software for the “Hello World” deSign ..........ooouiiiiiciii et 33
MAX10 FPGA Development Kit Cable Connections and Switch Settings........ccceeueiiiviiieiiiiiee e, 40
1Y oI U0 Y00 = o PP 45
Overview

This lab teaches you how to create an embedded system implemented in programmable logic
using Altera’s “soft” Nios Il processor. A soft processor such as the Nios Il, available in Altera’s
FPGA families, have built in programmable logic fabric and can be easily modified to suit an
application’s requirements. Altera’s “SoC FPGA” families are hard processor built from “hard”
standard cells that cannot be changed without redesigning the chip. The Nios Il processor is
supported by a rich set of peripherals and “IP” blocks built that can be configured and connected
to the processor using Altera’s QSys tool within the Quartus Il design tool set. Altera also
distributes the Nios Il Software Build Tools (SBT) for Eclipse (for software development) within
the Quartus development suite.

The lab is organized to run on a number of Altera development kits. The links to the other kits
can be found in the Design Store as a Design Example and type in “hello” in the search bar.
This lab will show you how to install the Max 10 Development kit pin settings, design the
processor-based hardware system, download it to the MAX 10 Development Kit, and run a
simple “Hello World” software program which displays text on your terminal. The initial section of


https://cloud.altera.com/devstore/platform/

the lab is split into a Hardware Section and Software Section. You can skip the hardware
section and move directly to the software section should you choose.

Refer to Appendix A in the Design Example for development kit specific pinout names and
configuration of on-chip memory.

Lab Notes

The lab will require you to choose files, components, and other objects; they must be spelled
exactly as directed. This is necessary for consistency and to ensure that each step works
properly in the lab, when creating your own systems you can choose your own names as long
as you use them consistently in your project. The directory paths shown in the figures are for
Linux (forward slash directory delimiter). If you are using Windows, the paths will be shown with
backslash directory delimiters.

Quartus Installation
Quartus is Altera’s design tool suite. It serves a number of functions:

1. Design creation through the use of HDL languages or schematics
2. System creation through the Qsys graphical interface
3. Generation and editing of constraints: timing, pin locations, physical location on die, 10
voltage levels
4. Synthesis of high level language into an FPGA netlist (“mapping” in FPGA terminology)
5. FPGA place and route (“fitting” in FPGA terminology)
a. Generation of design image (used to program FPGA, “assembly” in FPGA
terminology)
6. Timing Analysis
7. Programming/download of design image into FPGA hardware
8. Debugging by insertion of debug logic (in-chip logic analyzer)
9. Interfaces to 3rd party tools such as simulators
10. Launching of Software Build Tools (Eclipse) for Nios Il

To download Quartus, follow these instructions:
Visit this site: http://dl.altera.com/?edition=web to download version 15.1 of Quartus Il.
Select version 15.1 and your PC’s operating system.

For the smallest installation, and quickest download time, enter only the technology families you
are using based on your development board.


http://dl.altera.com/?edition=web
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Figure 1: Quartus download page

Follow the download instructions provided from the web page. No license is required to run the
Quartus Lite software.

Design Flow

Unlike system development with hard processors, development with soft processors enables
you to optimize the processor system to your application requirements and use the FPGA to
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add the performance and interfaces required by your system. This means that you need to know
how to modify the processor system hardware; this may sound challenging but thanks to the

Qsys graphical system design tool this is actually a relatively easy thing to do as we will
demonstrate in this lab.

The Qsys design flow diagram below illustrates how an overall system is integrated using the
combination of the Qsys system integration tool, Quartus for mapping (FPGA terminology for

synthesis), fitting (FPGA terminology for place and route), and the NIOS Software Build Tool
(SBT) for software development.

Qs

Define System
HIOL Files R ——— Syilerm Descnpln
& Make Connechions Lelipse
# = Generale Sysiem
4 Cuartus i ™ Mios SBET b

FPGA Design

= Edl
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Software
Development

& AOd Source Filkes
= Eoil

& Build
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# Timing Consiranis
= Compde
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%, e

‘ ' Targat |
Program FPGA m Downikoad Appicaion

Figure 2: Qsys Development Flow

The above diagram depicts the typical flow for Nios Il system design. Hardware System
definition is performed using Qsys; the resultant HDL files from the Qsys system are used by
the Quartus Il FPGA design software to map, fit and download the hardware image into the
FPGA device. Quartus Il also generates information that describes the configuration of the
system designed in Qsys so that the Nios Il SBT can be configured to create a software library
that matches the hardware system and contains all the correct peripheral drivers.

Objective of hardware design for the “Hello World” lab

For the simplest example, ‘a hello world lab’, the processor will load a program that prints “Hello
World” to the screen. This requires a working processor to execute the code, on-chip memory to
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store the software executable, and a JTAG UART peripheral to send the “Hello World” text to a
terminal. To make the lab a little bit more interesting and hardware-centric, we will utilize the
push button switches and LEDs to allow interaction with the development kit. We will show two
different ways to connect the push button to the LED, one through a direct connection in the
Verilog code using an assign statement, and one using connections to memory that the
processor can access. Note that in the appendix section, there are a number of more advanced
modules including how to connect to off-chip memory, utilizing interrupts and displaying hello
world on an LCD character display.

The lab hardware is constructed with the components shown below. Altera utilizes the Qsys
network on chip interconnect to connect the master and slave devices together. To get a clear
understanding of how quickly one can build an Embedded System using Qsys and the Quartus
Design Software you will build the Nios Il system entirely from scratch.

NIOS On-Chip JTAG Switches LEDs
Memory UART

Avalon

Figure 3: Nios Il based system used in this lab

HARDWARE DESIGN

Initial Setup

Should you want to skip the hardware design section, continue in the section called
SOFTWARE DESIGN. The screenshots in the hardware design section are based on the Max
10 FPGA Development Kit.

Altera provides a starting point design to get the FPGA device pinouts associated with the
development kits layout and your design via what is called the Baseline design. Navigate to
Altera’s design store for the kit that you are using: https://cloud.altera.com/devstore

Click on Design Examples.


https://cloud.altera.com/devstore

Dashboard » Design Store » D¢

Design Store

VS SISTT S Design Examples

o1 more development kits' them here

@ Take a tour

Family:| MAX 10 v Quartus II'Version:  Any v
Show 100 " entries Search:
Name 4 Category Family Device Version Vendor

ﬁ BeMicro MAX 10 FPGA Evaluation Kit Development Kit MAX 10 10MO8DA. 10 Arrow

E2 MAX 10 FPGA Development Kit Development Kit MAX 10 10M50DA 1.0 Altera

ﬁ MAX 10 FPGA Evaluation Kit Development Kit MAX 10 10M08SA 10 Altera

Non Kit Specific MAX 10 Design Examples Non-Kit Specific MAX 10 10M08SC 10 Altera

E2 Odyssey MAX 10 FPGA Kit Development Kit MAX 10 10M08SA 1.0 Macnica Americas
Showing 1 to 5 of 5 entries Previous 1 Next
Feedback| Help | Sofware | Site Terms | Privacy | Legal Notice Nk inX f [ »]

Copyright ® 2015 Altera Corporation. All Rights Reserved

Figure 4: Design Store

Once in Design Examples, filter by respective development kit and Quartus version number.

Design Store

Development Kits  [BESRITSTEN T ES

Find them here.

Looking for mor

Support Docs IP Cores Reviewers Contributers © Take a tour
nterested in contributing content to th

Family: MAX 10 Category: Any Quartus Il Version.  15.1
Development Kit: | MAX 10 FPGA Development [w] | 1P Core:| Any
show 100 [™ | entries X
Quartus 1I
Name Category Development Kit Family Version Vendor Downloads
E Max10 Development Kit Baseline Rev C and Rev B Pinout Design MAX 10 FPGA MAX 10 15.1.0 Altera 6 [ ]
Example Development Kit
Previous 1 Next

showing 1 to 1 of 1 entries (filtered from 24 total entries)

Figure 5: Design Examples under Design Store (note that this list changes over time and might not look the same as this

picture)

Select the MAX10 FPGA Development Kit Baseline Design or other supported development kit

you are using for this lab.



Dashboard » Design Store » Design Examples » Max10 Development Kit Baseline Rev C and Rev

m
o]

DESign Store Support Docs IP Cores Reviewers Contributors © Take a tour
Max10 Development Kit Baseline Rev C and Rev B Pinout

1410 15.0.0

Category
Name

Description

Operating System
Version

Family

Device

Documentation

Development Kit

Installation
Package

15.1.0

Design Example

Max10 Development Kit Baseline Rev C and Rev B Pinout

This design contains device pinout only and can be used as a starting point for designing with your MAX10 FPGA Development Kit. You can change the pin names as
needed in the Verilog HDL code and the .gsf files {or with the Assignment Editor). Pin locations are locked down on the board.

Read through the readme file to convert the Rev C baseline to Rev B baseline

None

1.0

MAX 10

10M50DA

# Add new documentation

MAX 10 FPGA Development Kit

! & Download

Figure 6: MAX 10 Development Baseline Design Example

Select the Download button and save the baseline.par design locally to your lab working
directory (call the directory devkit_hello_world).

Get started with Quartus
Now you are ready to get started designing hardware! Launch Quartus by double clicking the

Quartus icon.

Next you will launch the New Project Wizard from Quartus from the main panel or alternatively

Fiﬁ% New Project Wizard.

Home E |

Start Designing

Mew Project Wizard Open Project

O R Q@ e s

Recent Projects

5 fred.qpf (C:/Users/llandis/Documents/an490_design_example/fred.qpf)

(=) Hello_World.qpf (C:/Users/llandis/Documents/Hello_World_Lab/Hello_World.qpf)

(=) Hello_World_v1.qpf (C:/Users/llandis/Documents/Hello_World_Lab/Hello_World_v1.qpf)

5 foo.qpf (C:/Users/llandis/Documents/an488_design_example/foo.qpf)



Figure 7: Quartus Main Panel

Fill in the New Project Wizard first panel with your devkit_hello_world directory and project
which we will also call hello_world_lab.

# New Project Wizard <@sj-swcf5690-005>

Directory, Name, Top-Level Entity

What is the working directory for this project?
|fhomeﬂIandis!TEMP!devkit_hello_world

What is the name of this project?

[hello_world_lab =

What is the name of the top-level design entity for this project? This name is case sensitive and must exactly match
the entity name in the design file.

[hello_world_lab =

Use Existing Project Settings....

< Back ‘ Next = | Finish Cancel Help

Figure 8: New Project Wizard first panel

Click next and select project template and click next.
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4 Mew Project Wizard [
& j L

Project Type

Select the type of project to create.

() Empty project
Create new project by specifying project files and libraries, tarast device family and device, and EDA tool settings.

@ Project template
Create a project from an existing design template. You can choose from design templates installed with the Quartus II software, or download design
templates from the Design Store.

Figure 9: New project wizard second panel

¥ Design Template Installation <@sj-iccf03 O X

Design template file (par):
icit_MAXlD_HeIID_wcndfdevkit_baseline_revc.par

Destination directory:
|Idata!smeerflE.l!Dev_kit_MAJ(lD_HelIc:_wcmd

Cancel |

Figure 10: Design Template Install (note the name of the “.par” file will change based on the name of the development kit

you are using.
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Once you hit ok, Quartus loads this starting point design that contains the pinout for the specific
hardware device based on the Development Kit. Note that only a handful of pins are needed for
the lab, but you can rely on the settings utilized in the Baseline project to make sure the right pin
locations and voltage settings are correct for your project.

Building your Qsys based processor system

The Figure 11 diagram illustrates what you are designing in the Qsys environment. This system
has a single master, the Nios Il processor, and 4 slave devices. Building the Qsys system is a
highly efficient way of designing systems with or without a processor.

Launch Qsys from Quartus: Tools = Qsys. The initial screen looks something like this:

i Qsys - unsavedigsys* (fhome/llandis/TEMP/devkit_hello_world/unsaved.qsys) <@sj:swcf5690-011>
File Edit System Generate MWiew Tools Help
AP catalog — ot & 5 System Conterts 56| Address Map 3% | Imerconnect Requirements 53 =]
L nins %) @ System: unsaver
Project 4| _use [ conn Name Description Export Clack. Base End [ Tags
38 New Component. u B k.0 Clock Source
o System o ckin Clack Input lk exported
Library O clkin_resel Reset Input reset
¢ Basit Functions clk. Clock Output k0
@ Simulation; Debug and Yerification clk_reset Reset OurpLt
© simulation
= Altera Migs Il Custam Instruction Maj
® Altera Nios || Custom Instruction Slaf
% Processars and Peripherals
¢ Embedrlect Processars
= Mios Il {Classic) Processor
= Migs Il Gen2 Processor
Il T | ID
New. [ 00|
T, Hierarchy # | Device Family % -
03 unsaved
ook
o B= reset
e gk clk.0
< 1 D
| ft| 7| | current filter: Al Interfaces
% Messages B0 -fo
Twe | Path | Message
0 Errors, 0 arnings Generate HDL...

Figure 11: Qsys main panel

Next, we will add the various components of the system and make the connections between
them. By default Qsys inserts a clock module. We will connect to this later on in the lab.

Below the IP catalog tab, you can search for the various components you want to add to your
Qsys based system. Enter Nios in the search tab and select the Nios Il processor from the
library.

A configuration window will appear, in this select the Nios Il/e processor. This version of the

Nios Il processor is resource optimized and will work well for the Hello World Lab
implementation.
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R Nios Il Gen2 Processor

ogocors All2ra_nios2_gen2 Documentation

[~ Block Diagram ]

Main | Vectors | Caches and Memory Interfaces | Arithmetic Instructions | MMU and MPU Settings | JTAG Debug | Advanced Features

(] Show signals
[~ Select an Implemenigtiag_
nios2_gen2_0 | Mios ITEore: @ ios e
© Nios 1T
% .
=3 sanyction mesie Nios Il/e Nios II/f
= — ety Summary |Resource-optimized 32-bit RISC Performance- optimized 32-bit RISC
sl cniem. e Features | JTAG Debug ITAG Debug
2.0 Hardware Multiply /Divide
Instruction; Data Caches
Tightly-Coupled Masters
ECC RAM Protection
External Interupt Controller
Shadow Register Sets
MPU
MMU
RAM Usage |2 + Optians 2 + Options

@ Error: nios2_gen2_0: Reset slave is not specified. Please select the reset slave
I Error: nios2_gen2_0: Exception slave is not specified. Flease selact the exception slave

Figure 12: Nios Il Gen 2 Configuration panel

Click finish and you will see the Nios lle processor in your connection diagram. For now don’t
worry about the system errors reported, we will address them soon.

17 systern Contents 52 ‘ Address hap 32 ‘ Interconnect Reguirements & | = (= (=]
I:“:H:‘Syslem: unsaved  Path; nios2_gen2 0
Use Connections Marne Description Expaon Clock Base End IRQ
B ck_0 Clock Source
= clk_in Clock Input ok exported
E D clk_in_reset Reset Input reset
ik Clock Output clk_0
clk_reset Reset Qutpur
E‘ B nios2_gen2_0 Mios Il Gen2 Processor
clk Clock Input unconnecte
reset Reset Input [cIk]
data_rnaster Ayalon Memary Mapped Master [clk]
instruction_master Aavalon Memary Mapped Master [cIk]
irg Interrupt Receiver [clk] IRQ O IRD 31
debug_reset_reguest Reset Qutput [clk]
delug_mern_slave Aavalon Memory Mapped Slave [cIk] 0800 OxOFEF
custom_instruction_master |Custam Instruction Master

4] i [»

Figure 13: Qsys System Contents panel

Qsys has a very elegant and efficient way of making connections by clicking on the nodes on
‘wires’ in the connections panel on the 2™ column from the left. You can add the connections as

13



you add components, but it’s often easier to make all the connections once you have finished
adding the various blocks. With the Nios Il processor added, you still need to add the On Chip
Memory, JTAG UART, SWITCHES and LED to your system defined in Figure 3: Nios Il based
system.

Search for memory in the IP catalog. You will see many options for memory. It might be easiest
to detach the IP Catalog from the main panel by clicking on the detach window icon.

\p Catalog 22 = [

Figure 14: Detach window icon

A |p catalog 5% =
L memary b 4
Prujgl:t =
H New Comporent..
Library

% Basic Functions
¢ Bridges and Adaptars
¢ Memary Mapped
@ Ayalon-mMM DDR Memory Half REate Bridge
¢ On Chip Memaony

@ Ayalon FIFC Memory
@ Awalon-5T mMulti-Channel Shared Memony FIFO
= [0n-Chip Memary (RAM ar ROM)|
¢ Sirmulation; Debug and Yerification
¢ Simulation
@ Altera External Memoary BFM
9 Memory Interfaces and Contrallers

9 Processors and Peripherals
¢ Hard Processor Components

9 Qs Interconnect
¢ Memaory-Mapped
& Memaory-Mapped Arbiter
 Memory-Mapped Burst Adapter
» Memory-Mapped Combined sc_fifo Limiter
@ Memaory-mMapped Combined Wicth Adapter
“ Memory-Mapped Demultinlexer

il

Figure 15: IP catalog search for on chip memory

Locate the On-Chip Memory (RAM or ROM) component and click Add. You can use all of the
default settings except that you need to change the memory size from 4096 to 16384. This will
ensure that you have a plenty of space for your software program. Uncheck initialize memory
content. This feature includes the software executable in the hardware image. For this lab, you
will initialize the software executable from Eclipse.
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[ (4 parameters 3@]

—I:rl:ll

lSystem: nios_setup_v2  Path: onchip_memory

On-Chip Memory (RAM or ROM)

altera_avalon_onchip_memaory2

[* Memory type

Twpe: FAM {iritakble) -

[] Dual-port access

[ single clock operation
Fead During Write Mode:

|

Block type: ALTO
[~ Size
Diata width: 32 |v|
Total memary size: 16384 |b\ates

[ Minimize memory block usage {may impact frmax)

[~ Read latengy

Slave 51 Latency: EIZ|
Slave 52 Latency, :I:I

[~ ROM/RAM Memory Protection

Eeset Request: Enabled |w

[~ ECC Parameter

Extend the data width 1o support ECC bits! |nisanled |

[* Memory initialization

[ Initialize memaory content
] Enakle non-default initializ ation file

Tywpe the filename {e.g; my_ram.hex) or select the hex file using the file browser buttan.
User created initialization file:

[] Enahle In-System Memaory Content Editor feature
Instance 10

This memory is not initialized during device programming.

Figure 16: On chip memory configuration panel

Click finish and you will now see a total 3 components in your Qsys system: clock, Nios II
processor and on-chip memory.
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I system conterns 2 1 Address Map 2| Interconnect Reguirements &5 i [ {e=]
DDDSysmm: unsaved Path: onchip_memory2 _0
Use Connections Narne Description Expon Clock Base Endl IRQ
B dk_0 Clock Source
= clk_in Clock Input clk expored
E D clk_in_reset Reset Input reset
e Clock Output k0
clk_reset Reset Output
E‘ B nios2_gen2_0 Mins || GenZ2 Processor
E‘ clk Clock Input URCRRAECTE
reset Reset Input [cIk]
data_rnaster aealon Mernory Mapped Master [clk]
instruction_master iwalon Memory Mapped Master [clk]
irg Interrupt Receiver [clk] Ir0 O IRQ 31
debug_reset_request Reset Outpu [clk]
debug_merm_slave WAwalon Memory Mapped Slave [cIk] 0x0800 0x0FEF
custom_instruction_rnaster |Custorm Instruction Master
B onchip_memory2_0 On-Chip Memory (FaM or EOM)
clkl Clock Input URERRAETE
s1 \Aswalon Memory Mapped Slave [clk1]
resetl Reset Input [clk1]
« I I»

Figure 17: System contents with NIOSII and on chip memory

The next component you will add is the JTAG UART. Search for JTAG in the IP catalog, locate
the JTAG UART and double click or add that component. Keep the default settings and click
finish.

« JTAG UART - jtag_uart_0 <@sj-swcf5690-011> o X

“ JTAG UART
[~ Block Diagram 1K

Megocers  2ltETE_avalon_jtag_uart
| [~ Write FIFO (Data from Avalon to JTAG) L
[ ] Show signals Buffer depth (bvies): [g4 =

L o IR threshal: .

[[] Construct using registers instead of memory blocks

|v Read FIFO (Data from JTAG 1o Avalon)
Buffer depth (es): |gq —

i
hee
|gslon jrag slove | | IRQ threshold: B ]

akera_avalan_fiag wan

[] Construct using registers instead of memaory blocks

24 Wharning: jtag_uart_0: Jtag Uart input clock need to be at least SOMhz to operate properky

Figure 18: JTAG UART configuration panel

16



The next two components SWITCH and LED are actually configured instances of general
purpose parallel IO components in the IP catalog. Search for parallel IO (PIO) and select this
block. By using the PIO block for the switch and LED, you will be able to map the values of the
SWITCH and LED to address space and your C code will read and write these components. For
the switch block, you will set this up as a 1 bit input interface using the settings shown below.

“ PIO (Parallel 1/0)

Mogators  Al1EFA_AVAION_PID

=« PlO (Parallel I/O) - pio_0 <@sj-swcf5690-011>

[~ Block Diagram

Documentation

[] Show signals

)
| ¥| [~ Basic Settings

| width (1-32 hitsy: |2

pio_0

| Direction © Bidir
] & Input
O InOut

: ) Output
2| Output Port Reset Yalue

[~ Dutput Register

[] Enable individual hit setting,/clearing

“ Edge capture register

[ ]%wnchronously capture

Edge Tyne: I:D

[] Enable hit-clearing for edge capture register

‘| [ Interrupt

[l Cenerate IRQ

IR Type: I:D

Level: Interrupt CPU when any unmasked [fO pin is logic true
Edge: Interrupt CPU when any unmasked bit in the edge-capture
register is logic true. Available when synchronous capture is enabled

[* Test bench wiring

[ ] Hardwire PO inputs in test bench
Dirive inputs 1o:

@ Info: pio_0: PIO inputs are not harchired in test bench. Undefined values will ke read from PIO inputs during simulation.

Figure 19: Parallel 10 configuration panel

Next, you will add a second PIO block. Double click on the PIO component as you did for the
SWITCH. This time you will configure this component as the LED which is a 1 bit output.
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« PlO (Parallel I/O) - pio_l1 <@sj-swcf5690-011>

“ PIO (Parallel 1/0)

Megaters  AllEra_avalon_pio

[~ Block Diagram

[ 5how signals

pio_L

13

se1

1

sternal esnnetion
L —

i width (1-32 bits): E

ff Direction: 3 EBidir

Docurmentation

1
d |' Basic Settings

) Input
2 InGur
@ Qutput

i outpun Port Reset value: [0x0000000000000000

|' Output Register

[[] Enable incivicual bit setting/clearing

|' Edge capture register

O synchronoushy capture

Edge Type I:D

[ Enakle bit-clearing for ecge capture register

| [ Interrupt

[ Cenerate IRQ

|revee [EET
2| Level: Interrupt CPU when any unmasked /0 pin is logic true

| Edge: Interrupt CPU when arry unmasked bit in the edge-capture
2| register is logic true. Available when synchronous capture is enabled

[~ Test bench wiring

[] Hardwire PIO inputs in test bench

i Drive inputs

Click finish. You have completed adding the 6 components that make up your Qsys system.
Next you will rename the components in the design with names that are easy to remember.

In the system contents tab, right click on the nios2_gen_2_0 component, select rename and
type in nios2e, similarly rename the rest of the components: onchip_memory, uart, switch and
led. This will make these components hames easy to remember and reference in future steps.
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)

I: Systern Contents 22 Address Map &0 Intercannect Requirements &2 =
DDDSyslem:unsa\fed Path: onchip_memory
lUse Connections MName Description Export Clock Base End IRG Tags Opcode N
B dk_0 Clock Source
CH clk_in Clock Input ck exported
= clk_in_reset Reset Input reset
clk Clock Qutput clk_0
clk_reset Reset Output
B nios2e Mios | GenZ2 Processor
clk. Clock Input pRERRIE TR,
reset Reset Input [clk]
data_masier Awalon Memory Mapped Master [clk]
instruction_master Awalon Mermory Mapped Master [clk]
irg Interrupt Receiver [clk] IR0 O IR0 31
debug_reset_request Reset Qutput [clk]
debug_mem_slave Awalon Memory Mapped Slave [clk] 0x0800 x0T
custom_instruction_master \Custom Instruction Master
B onchip_memory On-Chip Memory (RAM or ROM)
clkl Clock Input PRI TR,
sl Awalon Memory Mapped Slave [clk1]
resetl Reset Input [clk1]
O van TAG LART
clk Clock Input PRERRNEITE,
reset Reset Input [clk]
avalon_jtag_slawe Avalon Memory Mapped Slave [clk]
i Interrupt Sender [clk]
B switch FIO (Parallel 1/0)
clk Clock Input PRI TR,
reset Reset nput [clk]
sl Avalon Memory Mapped Slave [clk]
external_connection Conduit
B led Pl {Parallel 1/0)
clk Clock Input HRERRIE TR,
reset Reset nput [clk]
sl Awalon Memory Mapped Slave [clk]
external_cannection Conduit

Figure 21: System Content connections starting panel

The next step consists of making the appropriate connections between the components within

Qsys.

Click on the clk net coming out of clk_0. When first selected, it will be gray color. Make
connections by clicking on on the small open circles on the lines that intersecting with the 5
other components.

You should see something similar to Figure 22.

12 system Coments

£ | Address Map &2

DDDSyslem: unsawed  Path: led. clk

Imerconnect Reguirements %8

Figure 22: System contents after clock connection
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Use Connections Mame Description Export Clock Base End IRQ
= k.0 Clack Source
[mg clk_in Clock Input clk experted
(B clk_in_reset Resat Input reset

clk Clock Qutput clk_0
clk_reset Resat Output

EIDQ nios2e Mios 1| Gen2 Processor
clk Clock Input cli_0
reset Resat Input [clk]
data_master Aalon Mermory Magped Master [clk]
instruction_master valan Memory Mapped Master [clk]
irg Interrupt Receiver [clk] IR0 O IRO 31
debug_reset_request Feset Output [clk]
debug_mem_slave lAwalon Memory Mapped Slave [clk] 0x0800 Qx0T
custar_instruction_master (Custorm Instruction Master

B onchip_memory On-Chip Memory (RAM ar ROM)
clk1 Clock Input clk_0
sl valon Memory Mapped Slave [clk1]
resetl Reset Input [clk1]

B wart UTAC UART
clk Clock Input clk_0
reset Reset Input [clk]
awalon_jlag_slawe valon Memory Mapped Slave [clk]
irg Imterrupt Sender [clk]

B switch FIO (Parallel |/0)
clk. Clock Input clk_0
reset Reset Input [clk]
sl Avalon Memory Mapped Slave [Clk]
external_connection Conduit

= led FIO (Parallel |/0)
clk. Clock Input clk_0
reset Resat Input [clk]
sl Avalon Memory Mapped Slave [Clk]
external_connection Conduit




Perform the same operation to connect the clk_reset to the resets on the other components.

Next, connect the nios2e data master to the slaves.

Make the connections between the Nios2e data master and the s1 connection of the onchip

memory, avalon_jtag_slave on the uart, s1 port on the switch and s1 port of the led component
as shown below. Instruction master -> debug_mem_slave

t: Systemn Contents &2 | Agdress Map  £2 | Interconnect Reguirements 22

System: unsaved  Path:led s1

4r || Use Connections hame Description Export Clock Base End IR Ta
[= B dk_0 Clock Source
= =l clk_in Clock Input clk exported
X (o clk_in_reset Reset Input reset
= —_———— clkc Clock Output clk 0
—— ¢ clk_reset Reset Output
= ElD,Q nios2e Mios || Cen2 Processor
a clk Clock Input clk_0
reset Feset Input [clk]
e — clata_master walon Memory Mapped Master [clk]
instruction_master walon Memory Mapped Master [clk]
irg Interrupt Receivar [clk] IR0 O IR0 31
debug_reset_request Reset Output [clk]
’ cebug_mearm_slawe walon Memory Mapped Slave [clk] 0x0800 0x0FFT
custom_instruction_master |Custom Instruction Master
B onchip_memaory On-Chip Mermaory (RAM ar ROM)
clkl Clock Input clk_0
sl walon Memony Mapped Slave [clk1] 0x0000 0x3FFT
resetl Reset Input [clk1]
B uart ITAG UART
clk Clock Input clk_0
reset Reset Input [clk]
avalon_jtag_slave walon Memory Mapped Slave [clk] 0x0000 0x0007
irg Interrupt Sender [clk]
B switch PIO (Parallel 1)
clk Clock Input clk_0
reset Reset Input [clk]
s1 walon Memory Mapped Slave [clk] 0x0000 03000 T
external_connection Conduit
E led P10 (Parallel 10y
clk Clock Input clk_0
reset Reset Input [clk]
sl Awalon Memory Mapped Slave [clk] 0x0000 0x000 T
external_cannection Canduit

Figure 23: System contents after data master/slave connection

The instruction master signal from the nios2e component does not need to be connected to
each slave component as it only needs access to memory that contains the software

executable.

Make

onchip_memory s1.

the connection between
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1= system Contents 5% | Address Map  £2 | Interconnect Requirements &2
System: unsawed  Path: onchip_memonrygsl
4r|| Use Connections Mame Description Expart Clock Ease End IRQ Taas
= B ck_0 Clock Source
=g clk_in Clock Input clk exporied
,“ (= clk_in_reset Feset Input reset
= —_— clk Clock Output cll_0
- —— clk_reset Reset Output
= B nios2e Mios || Gen2 Processar
a clk Clock Input clk_0
= reset Feset Input [clk]
data_master Avalon Memory Mapped Master [clk]
= instruction_master Avalon Memory Mapped Master [clk]
irg Interrupt Receiver [clk] IR0 O IR 31
debug_reset_request Feset Qutput [clk]
debug_mem_slave Avalon Memory Mapped Slave [clk] Ox0800 x0T
custom_instruction_master (Custom Instruction Master
B onchip_memory On-Chip Memory (RaM or ROM)
clkl Clack Input ck_0
s1 Avalon Memory Mapped Slave [clkl] 0x0000 OITFT
resetl Feset Input [clk1]
B uart ITAG UART
clk Clock Input dk_0
reset Reset Input [clk]
avalon_jtag_slave Avalon Memory Mapped Slave [clk] 0x0000 00T
irg Interrupt Sender [clk]
B switch PIO (Parallel 1f0}
clk Clock Input dk_0
reset Reset Input [clk]
s1 Avalon Memory Mapped Slave [clk] 0x0000 00T
external_cannection Caneluit
B led PIO (Parallel [0)
clk Clock Input clk_0
reset Reset Input [clk]
s1 Avalon Memory Mapped Slave [clk] 0x0000 00T
external_cannection Cancluit

The next connections to make are the processor interrupt request (IRQ) signals. The UART can
drive interrupts and hence needs to be wired to the nios2e processor interrupt lines. Make this

Figure 24: System contents after instruction master/slave connections

connection as shown in Figure 25. We will use the default setting for the IRQ number.

1 Systern Contents 3 Address Map 2% | Interconnect Requirements %
System: nios_setup_w2  Path: uart.irg
4| Uze Connections Marne Descriptian Expart Clock Base Endl IRQ
,,q B dk_0 Clock Source
(=g clk_in Clack Input clk exported
X O clk_in_reset Resat Input reset
EZ — clk Clock Dutput clk_0
- —— 7 clk_reset Reset Output
= EQ nios2?e Mios I Cen2 Processor
a clk Clock Input clik_0
> reset Feset Input [clk]
—_— data_master Asealon Memory Mapped Master [clk]
= S — instruction_master Awalon Memory Mapped Master [clk]
irg Interrupt Receiwer [clk] IROD O IRQ 31
debug_reset_reguest Reset Output [clk]
debug_mem_slave Awalon Mermary Mapped Slave [clk] 0x0800 OxOFFF
custarn_instruction_master |Custarn Instruction Master
B onchip_memory On-Chip Mermory (RAM or ROM)
clkl Clock Input clk_0
sl Awalon Memory Mapped Slave [clk1] ox0000 Ox3TFT
resetl Resat Input [clk1]
B uart ITAG LART
clk Clock Input clk_0
reset Reset Input [clk]
avalon_jtag_slave Awalon Memory Mapped Slave [clk] Ox0000 0xO007
| irg Interrupt Sender [clk]
B switch PIO {Parallel 10}
clk Clock Input clk_0
reset Resat Input [clk]
51 Awalon Memory Mapped Slave [clk] Ix 0000 0x000
external_cannection Canduit
2 led PIO (Parallel 10}
clk Clack Input clk_0
reset Reset Input [clk]
sl Aoalon Memory Mapped Slave [clk] ox0000 0x00 T
external_connection Canduit

Figure 25: System contents after interrupt connections

You have now completed the internal connections for this Nios Il processor based system. The
next step is to make the external connections that connect the Qsys based system to the next
higher level in the hierarchy of your FPGA design, or to FPGA device pins that connect to the
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PCB. Double click on the switch and led conduit items under the export column circled in Figure
26. This will bring these ports out of the Qsys component to connect to the top level design.

I: Systemn Contents &8 Address Map &% | Interconnect Requirements &8

System: nios_setup w2 Path: uartirg

qa|| Use Connections Hame Description Export Clock Base End 1RO
,,G 2 dk_0 Clock Source
= (=g cll_in Clock Input clk exported
“’i. (=g clk_in_reset Resat Input reset
ER —_—— clk Clock Cutput clk_0
— T clk_reset Reset Output
= B8 nios2e Migs Il Gen2 Processar
& clk Clack Input clk_0
= reset Reset Input [clk]
— data_master Awalon Mermory Mapped Master [clk]
= —T instruction_master Awalon Memary Mapped Master [clk]
irg Interrupt Receiver [clk] IRQ O IRQ 31
debug_reset_reguest Resat Output [clk]
debug_mem_slawve Awealan Memory Mapped Slave [clk] 0x8800 08T
custom_instruction_rmaster |Custom Instruction Master
B onchip_memory On-Chip Memory (RAM or ROM)
k1l Clock Input clik_0
51 Awalon Memory Mapped Slave [clk1] Ox4000 Ox7TEf
resetl Resat Input [clk1]
B uart ITAC UART
clk Clock Input clk_0
reset Resat Input [clk]
avalon_jtag_slave Awalon Mermary Mapped Slave [clk] 0x9020 0%8027
| am— irg Interrupt Sender [cIk]
B switch FIO (Parallel 10}
clk Clack Input clk_0
reset Reset Input [clk]
sl Awalon Memory Mapped Slave fell] 0x9010 0x@01 T
o external_connection Caonduit switch_external_conn... 3
B led FIO (Parallel 10} —
clk Clock Input clk_0
reset Reset Input [clk]
51 Awalon Memory Mapped Slave 1k] 0x9000 03300 f
<1 external_connection Conduit led_external_connecti... H

Figure 26: System contents after exporting PIO switch and LED

Next you will need to generate the base Addresses for your Qsys system. This is achieved by
using the command System - Assign Base Addresses.

Save your Qsys system by using File = Save As and pick a name for the Qsys system that you
will remember. Note that the lab figures call it nios_setup_v2 so to avoid confusion you should
name your .gsys file the same. The information is saved in what is called a .gsys file. Although
you are not entirely finished, it's good practice to save edits along the way.

You should see 2 error messages in the Message Console of Qsys. They are shown in Figure
27.

o= Messages %

Type Path Message
[ ] 2 Errors
£  |nios_setup_vZ.niosZe Reset slave is not specified. Please select the reset slave
& |nios_setup_vZ.niosZe Exception slave is not specified. Flease selact the exception slave
T @ 1 Info Message
] nios_setup_v2.switch FIO inputs are not hardwired in test bench. Undefined walues will be read from PIO inputs during simulation

Figure 27: Error message prior to assigh memory location to execute from

These error messages have to do with the fact that nios2e processor doesn’t know where the
software code that handles resets and exceptions is located. This is fairly straightforward to fix.

Double click on the nios2e component and set the reset vector memory and exception vector
memory both to onchip_memory.s1. This will set the system to execute from onchip memory at
these respective locations upon reset or interrupt. The 2 errors that were shown in Figure 27
should now be resolved.
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[ parameters & = [ (=)
System: nios_setup_we  Path: nios2e

Nios Il Gen2 Processor
altera_nios2 _gen2

Details

[»

Main [ Wectors r Caches and Mermory Interfaces rArithmetic Instructions r MMU and MPL Settings rJTAG Debug rAcl\ranced Features

[~ Reset Vector

Eeset wvector memaory: onchip_memary.s1 |v|
Reset vactor offset: 0x 00000000
Reset vectar: 0x00004000

[* Exception Vector

Exception wector memaor,. onchip_rmemorys1 |v|
Exception wector offset; Qx00000020
Exception wectar: Ox00004020

[~ Fast TLB Miss Exception Vector
Fast TLE Miss Exception wector memary: | | |

Fast TLE Miss Exception wector offset;
Fast TLE Miss Exception wector: Qx00000000

Figure 28: Assign vectors in the NIOS2E panel

Save your design once again. Note that by saving, you still have not generated the files that you
need for Quartus Il compilation or with the Eclipse SBT. The step to complete this is to click on
the button on the lower right of Qsys.

Click on the button ‘Generate HDL'.
Click Generate on the panel that appears.

Congratulations, this completes the Qsys section of the lab.

23



« Generation <@sj-swcf5690-011> ms 4

[~ Synthesis |

Synthesis files are used to compile the system in a Quartus Il project.

Create HOL design files for synthesis: =

[[] Create timing and resource estimates for third-party EDA synthesis toaols.

Create hlock symbol file  bsf)

[~ Simulation

The simulation model cantains generated HOL files for the simulator, and may include simulation-only features.

Create simulation model: Mone =

[ allow mixed-language simulation

Enahble this if wour simulator suppors mixed-language simulation.

[~ Output Directory |
Path: |,fh0me,fllandis,fTEMP,fdE\.kit_helID_WurId,fniUs_setup_\Q |D

Cenerate || Cancel

Figure 29: Generating the Qsys system HDL files

Building the top level design

The next step will take a little bit of knowledge in Verilog. Should you want to use a schematic
capture graphical editor, jump to the Error! Reference source not found.. If you are familiar
with VHDL, you can make the same connections in VHDL, but you will have to change the
design to VHDL on your own. For ease of following along the lab document, we recommend
continuing the lab in Verilog. During the early steps using the project wizard, you loaded the
baseline design, and have a baseline.v preloaded in the Quartus project. We will take a look at
this starting point baseline.v file and strip out the unnecessary signals, while only leaving the
signals that are needed to run the Hello World design. It is important to note that each
development kit used has its own names for clocks, switches, pins and so you will need to use
the right names according to the development kit naming convention.

Quartus should be open, bring that to the front of your screen. Make sure the hierarchy tab is
highlighted and double click the baseline design. Note that for this design there is a clock, reset,
push button inputs, LED outputs, and a JTAG UART. The JTAG UART pins are hard wired into
the FPGA so you don’t need to add them in your Verilog source file. The 4 pins: TCLK, TDI,
TMS and TDO that constitute a 4 wire JTAG interface are at a fixed location in your FPGA and
they don’t need to be added to your Verilog source file. Only pins that are synthesized from your
RTL source code need to be specified. The baseline design includes all non hard-wired device
pins and you will need to delete extra pins and include the following pins in the port list:
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CLK_50 _MAX10, CPU_RESETnNn, USER_PB, USER_LED. Delete all other pins from the port
list. The original baseline.v is shown in Figure 31. Make the changes including changing the
module from baseline to hello_world and save the file as hello_world.v.

CLK_50_MAX10

CPU_RESETn

USER_PB[1:0]

USER_LED[1:0]

TCK Hello World

TMS

JTAG
TDI

TDO

A

Figure 30: Block diagram of hello_world design for the MAX 10 FPGA Development Kit.

Important Note: The pin names throughout this section reflect the names for the MAX 10
FPGA Development Kit. Refer to the table below for the naming convention for the other
kits supported by this lab.

MAX 10 FPGA
Development Kit

BeMicro MAX 10

Cyclone V E FPGA
Development Kit

DECA MAX 10
Development Kit

CLK50_50_MAX10

CLK50_50_MAX10

CLKIN_50_FPGA_TOP

MAX10_CLK1_50

CPU_RESETn CPU_RESETn RESET_EXPN RESET_EXPn
USER_PB USER_PB USER_PB KEY
USER_LED USER_LED USER_LED LED
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|‘times::.ale 1 ps J 1 p=
Emodule baseline |
S /Re=set and Clocks

I input clk ddr3 100 p,
input CLE S50 MRX10,
input CLE 25 MRX10,
input CLE LVD5 125 p,
input CLE 10 &aDC,
input CPU_RESETn,

//LED PE DIPSW

output [2:0] USER_LED,
input [3:0] USER_FE,
input [4:0] USER_DIFPSW,
S /USE

input USB_RESETn,
input USB_WRn,
input USB_RDn,
input USB_OEn,
inout [1:0] USE LDDE,
inout [7:0] USE DLTL,
output USB_FULL,
output USB_EMPTY,

input USB_S5CL,

.

Figure 31: Original baseline.v design with MAX 10 FPGA Development Kit signal names

& hello_world.v* B ]
AT EE a0 Tom 08 Y Ey | 2EE

Il

1 “timescale 1 ps / 1 ps

2  [Emodale hello world |

3 J/Reset and Clocks

4 input CLE_50 MAX10,
5 input CPU_RESETn,
&

7 //LED PE

B output [4:0] USER LED,

g input [3:0] USER PB) ;
10

11 =

12 endmodule

13

Figure 32: Edited baseline MAX 10 Development Kit design with pins removed. Note save as: hello_world.v
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Next we need to check that the hello_world.v file is included in your project. Note that it should
be the only file in your project so far. Go to Project > Add/Remove Files in Project. Confirm that
hello_world.v is listed.

¢ Settings - hello_world_|lab <@sj-swcf5690-011> 0 X

Category:
Libraries Select the design files you want to include in the project. Click Add All to add all design files in the project
- IP Settings directory to the project.
IP Catalog Search Locations )
Design Templates File name: | Add

-t Operating Settings and Conditior

Voltage File Name |Type |Library |Design Entry/Synthesis Tool | HDL Version Add Al

hello_world.v Verilog HDL File =MNone= Default

Temperature
- Compilation Process Settings Remove

Incremental Compilation

-l EDA Tool Settings Up

Design Entry/Synthesis

Simulation Down

Formal Verification
Board-Level Properties
- Compiler Settings

VHDL Input

Verilog HDL Input

Default Parameters
TimeQuest Timing Analyzer
Assembler
Design Assistant
SignalTap Il Logic Analyzer
Logic Analyzer Interface
PowerPlay Power Analyzer Settir
SSN Analyzer

4 | ]

1] | ﬂ QK | Cancel| Apply | Help |

Figure 33: Add/Remove Files pane

Next you need to make the top level entity hello_world since its currently set at baseline. In the
same window upper left corner, click on General. Change baseline to hello_world. You can also
change by right clicking on the hello_world.v and set as top level entity.
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¢ Settings - hello_world_lab <@sj-swcf5690-011> - 0 X

Category:

Files
Libraries
—I-IP Settings
IP Catalog Search Locations
Design Templates
-l Operating Settings and Conditiol
Voltage
Temperature
-l Compilation Process Settings
Incremental Compilation
EDA Tool Settings
Design Entry/Synthesis
Simulation
Formal Verification
Board-Level
- Compiler Settings
VHDL Input
Verilog HDL Input
Default Parameters
TimeQuest Timing Analyzer
Assembler
Design Assistant
SignalTap Il Logic Analyzer
Logic Analyzer Interface
PowerPlay Power Analyzer Settir
S5SN Analyzer

Device. ..

You can change the top-level entity for the design; however, it is recommended that you create a new
revision for each entity in order to maintain settings information.

Top-level entity: |hE||0_W0r|d =
Recently selected top-level entities: |[§=lETTgl | <
Description:

OK Cancel Apply Help

Figure 34: Settings pane

Click OK when complete. Now it is a good idea to make sure your Verilog is syntactically
correct. Return to the main Quartus window and select the Tasks pane. Double-Click on the
Play (right triangle) for analysis/synthesis. You will get warnings but you should get no errors. If
you do get an error, it’s likely syntax (eg missing semicolon). Make changes, save, and continue
to run analysis/synthesis until the Verilog runs error/free (ignore dangling pin warning for now).
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¥, Quartus Il 64-Bit - /home/llandis/TEMP/devkit_hello_world/hello_
File Edit View Project Assignments Processing Tools Window He

L
X

USSP 6 a@B 9~ Ihello_wond_lab
Tasks & x

Flow: [Compilation ~| Customize... |

I Task | o =
- » Compile Design
v oy 0000
= Fitter (Place & Route)
] Edit Settings
" View Report
& Chip Planner
3 Technology Map Viewer (Post-Fitting)
+ » Design Assistant (Post-Fitting)
- P Assembler (Generate programming files)
] Edit Settings
= View Report
- » TimeQuest Timing Analysis
] Edit Settings
= View Report
{J TimeQuest Timing Analyzer

+ P EDA Netlist Writer | v
>|

' Tasks I]Pro]ect Navigator | <

\omqmu&wwo—kﬂ.

-
N = O

Figure 35: Task pane

The baseline design that you uploaded in the prior steps contain all of the pin settings needed
so that the pin locations are consistent with how the MAX 10 device is connected for the PCB
on the MAX 10 Development Kit. You can inspect the pin setting locations to understand where
they come from. Launch Assignments - Assignment Editor. You will see a list of pins in
spreadsheet form that contain pin (package ball to be specific) locations, 10 standard and
current strength settings. Note that you are not using all the pins in the design, but this is ok —
Quartus will ignore pin assignments that are not referenced in your design.
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‘ e hello_world. v x| | 5 Agsignment Editor x| |
sem tnew=> * [J] Filter on node names: = - Categnry:[nﬂ -
tatu From To Assignment Mame Value Enabled Entity
1« I i clk D..100_n Location PIN_N15 Yes I
2 « I i Clk.D..100_p Location PIN_N14 Yes ]
3 « I i cix_.AX10  Location PIN_M3 Yes ]
2 « I i clk_ Ax10  Location PIN_M8 Yes ]
s« [ i clk_10_ADC  Location PIN_NS Yes ]
& « I i clkL..125 0 Location PIN_R11 Yes ]
7 « I i ClkL..125p Location PIN_P11 Yes ]
8 « I ;> cPu_RESETn  Location PIN_D9 Yes ]
s« [ i ooR3_A[0]  Location PIN_V20 Yes ]
1w« [ i 0oR3_A[3]  Location PIN_UZ0 Yes ]
11« [ i DOR3_A[5]  Location PIN_F19 Yes ]
12« N > 0DR3 A[5]  Location PIN_E21 Yes ]
13« [ i OoR3_A[E]  Location PIN_D22 Yes ]
14« [ P 0DR3_A[9]  Location PIN_E22 Yes ]
15« N @ DDR3_A[10]  Location PIN_Y20 Yes ]
15« [ i DOR3_A[11]  Location PIN_E20 Yes ]
17« [ & DOR3_A[17]  Location PIN_J14 Yes ]
15+ [ i DOR3_A[13]  Location PIN_C22 Yes ]
19« N 3> 0oR3 BA[D]  Location PIN_v22 Yes ]
2 « [ i OoR3BA[1  Location PIN_N18 Yes ]
21« [ i OoR3_BA[Z]  Location PIN_W22 Yes ]
Ll — - - i L

Figure 36: Assignment Editor

Note: Some of the pin names in the list above might differ from the names assigned when you loaded
the baseline design. In a future section, you will be instructed to change some of the pin names to match

what is being used in this specific design.

Adding the Nios II system into your design

Now that you have the hello_world entity completed and syntactically correct, you will need to

add the Nios Il Qsys system into your design. Qsys makes this task quite convenient. Go to File

- Open and navigate to the name of the Qsys project you created (the one shown in the lab is
called nios_setup_v2). You should see a file called nios_setup_v2_inst.v . Open this file and
you see how to instantiate (fancy word meaning placing this component in your design) the

Qsys system. The contents of this file are shown below:
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nios2e_inst.v

e

e |
| = EES

=1 O Wi b B

) s

hello_world v [ &
HaMT EE 00l Don 0
= nio=2e uld |
.clk _clk

.reset_reset n

.ph_external connection export

{<connected-to-clk_clk>),

(<connected-to-reset_reset_n=),

(=connected-to-pb_external_connection export=),

.led external connection export (<connected-to-led external connection export>)

You will need to connect the 10 ports to the nios_setup_v2. Copy the entire contents of the
nios_setup_v2 file by highlighting and copy (ctrl-c), followed by inserting into the Verilog file
hello_world.v and pasting (ctrl-v). Next we will connect the push button switches to the LEDs in
two different ways to demonstrate how the connection can be made through the FPGA fabric,
and in the software that we use that the Nios Il executes. To simplify knowing which push button
is connected through hardware and which one through software, we will invert the hardware
connection so that activating push buttons 0 turn off LEDs through a hardware connection, while
activating push buttons 1 turn on the respective LEDs. Take one push buttons ([0]) and connect
to LEDs[0] with an inverted assignment (see line 11 in Figure 37). The LEDs [1] will be
connected non-inverted in software by connection to the Qsys system. Note that the
USER_LED for the MAX 10 Development Kit (note that the number varies by kit) is defined as 5
bits wide, [4:0], but you have only used 2 LEDs in total: bit 0 is connected through the FPGA
fabric, and bit 1 is connected through application software. USER_LED [4:2] are unconnected
and will give a dangling wire warning message when you compile, this is ok. Click the save icon
or File > Save.

| & hello_world.v [5¢] | = Assignment Editor |
=R T = A DOH 08 28 | 2EEE
‘timescale 1 ps / 1 ps

2 Blmodule hello world (

3 //Reset and Clocks

4 input CLK_50 MEX10,

5 input CPU_RESETn,

L3

7 //LED PB DIPSW

8 output [4:0] USER_LED,

g input [2:0] USER_PB,

10

11 assign USER LED[1:0] = ~USER_PB[1:0]:

iz

13 =] nios_setup_v2 ul (

14 .clk_clk (CLE_50 MAX10), I [+
15 .led external connection exXport (USER_LED[3:2]), led _external connection.export
16 .FesSet_reset_n (CPU_RESETn), reset.reset
17 .switch external connection export (USER_PE[3:2]) // switch_external connection.export

18 Vs

13

20 =

21 -endmodule

22

Figure 37: hello_world.v after making connections to nios system and adding led to push button assignment
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You now have completed the creation of the Nios Il system using Qsys, instantiating this
component into the top level design, and making connections from led to push buttons for
testing in your Verilog file called hello_world.v. You now add the Nios Il system into your project
using the Project > Add/Remove Files in Project command. Instead of adding individual Qsys
generated Verilog files and settings into the project, you add the NIOS gip file which is located
under: nios_setup_v2/synthesis/nios_setup_v2.qip . The qip file contains pointers to the location
of all the generated source files generated from Qsys and necessary settings required to

compile. You can open this file in a text editor to see its content. Navigate using the J button
and select the file. Hit Add followed by OK.

¢ Settings - hello_world_lab <@sj-swcf5690-011> — O %
Libraries Select the design files you want to include in the project. Click Add All to add all design files in the project

directory to the project.

- IP 5ettings
IP Catalog Search Locations ) B —— -
Design Templates File name: |n|0s_setup_\.rZIsynthemsmms_setup_\.rz.q|p Add
- Operating Settings and Conditiol - R ; ; -
Voltage File Name |Type |L|brary | Design Entry/Synthesis Tool |HDL Version Add All
Temperature hello_world.v Verilog HDL File =None> Default

- Compilation Process Settings Remove

Incremental Compilation

-I- EDA Tool Settings Up

Design Entry/Synthesis

Simulation Down

Formal Verification
Board-Level Properties
-t Compiler Settings

WHDL Input

Werilog HDL Input

Default Parameters
TimeQuest Timing Analyzer
Assembler
Design Assistant
SignalTap Il Logic Analyzer
Logic Analyzer Interface
PowerPlay Power Analyzer Settit
SSN Analyzer

4 | |

Help

1] | ﬂ oK Cancel | Apply

Figure 38: Add/Remove Files from Project - .qip file

Now you can compile your design which will run analysis & synthesis, fitter (place and route in
FPGA terminology), Assembler (generate programming image) and TimeQuest (the static timing
analyzer). This can be achieved by clicking on the play button as shown in Figure 39.
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Figure 39: Compilation button

Note that some warnings and information messages come up in the bottom window.

You can filter by message level. The errors are filtered with the ﬂ button, critical
= i 15 )
warnings with the i? button,warnings with the ' “** | button and informational messages with

]
the ﬂ button. You cannot proceed if you have errors. In this case there are only critical and
standard warnings, primarily because we did not add timing constraints to this project. Due to
the simplicity of this design and low frequency, it’'s okay to start without timing constraints.
Consult other Altera online training courses for instructions on how to add timing constraints to
your design.

Type ‘ ™ ‘1.1
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Figure 40: Filter for critical warnings

Congratulations, your FPGA hardware design is now complete.

Adjusting Pin Names

The pin naming convention for every development kit supported by this lab can be different. For
instance some kits name the push buttons USER_PB and others call it KEY. You will need to
check the Appendix A for which pin names you will need to change in the assignment editor to
make sure they are properly mapped when running the compilation step. To see if you need to
adjust the pinout names, do the following: (LL).

SOFTWARE DESIGN

Creating the Software for the “Hello World” design

Should you choose to start directly in the Software Design section and skip the Hardware
Design section, consult with your lab facilitator to get these two files: nios_setup_v2.sopcinfo
and hello_world_lab.sof as if you generated them from the Hardware Design lab. You will be
able to complete all subsequent steps with these two files.

The NIOS Software Build Tools for Eclipse are included as part of Quartus. These tools will help
manage creation of the application software and Board Support Package (BSP). Launch the
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SBT Tools = NIOS Il Software Build Tools for Eclipse (Tools -> Nios Il Software build tools for
Eclipse). You can use the default location that Eclipse picks for you.

f Workspace Launcher <@sj-swcf5690-011=> -

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: |/home/llandis/TEMP/devkit_hello_world/Workspace

[ Use this as the default and do not ask again

Cancel l l QK

Figure 41: Initial Workspace setup

Click OK in the Workspace launcher.

Next, the Eclipse SBT will launch. Right click in the area called Project Explorer and select
New->Nios Il Application and BSP from Template. The BSP is the “Board Support Package”
that contains the drivers for things like translating printf C commands to the appropriate
instructions to write to the terminal.
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Nios Il - Eclipse <@sj-swcf5690-011>

File Edit Navigate Search Project Niosll Bun Window Help

e | foiE -6 - & - @ -i%-0-@Q-ig ¢ -1 § x |
[Quckaccess i
[i5 Project Explorer 2 S = 0 o= Outline 2 = g
B S = =

An outline is not available.

[ Project..

23 Import... Nios || Application
1 Export... Nios Il Application and BSP from Template !
. Nios Il Board Support Package
# | Refresh F5
Nios Il Library

Y other... Ctri+N

B Problems 2 & Tasks El Console Properties ¥ o= 8
0 items

Description Resource Path Location Type

0 items selected

Figure 42: Creating the initial project in the Eclipse SBT

Next you will see a panel that requests information to setup your design. First, you need to
navigate to your working directory and click on the .sopcinfo file. The .sopcinfo file informs
Eclipse on what your Qsys system contains. Click OK.
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{ | Nios Il Application and BSP from Template =@sj-swcf5690-011>

MNios Il Software Examples

Please specify a .sopcinfo file

Target hardware information

SOPC Information Fle name: [ ] D

f <@sj-swcf5690-011> 4

| 9| Dhﬂ llandis || TEMP || devlcll:_hellu_wnrld|

Location: [nius_setup_vz.supcinfu l

Places Marme | Modified _ E
%@ llandis 0 output_files Yesterday
& Desktop J patch 03/03/15
© File System = platform 03/03/15
- [ simulation 03/03/15 || |
% I software 03/04/15
] [J nios_setup sopcinfo 02/28/15 ||=
[J nios_setup_ll.sopcinfo Friday
W nios_setup w2 .sopcinfo Yesterday

| | = | SOPC Information File (* sopcinfo) | %

| ¥ Cancel || @QK

® ” |[ Cancel H

Figure 43: Navigating to correct .sopcinfo file

Fill in the Project name. Call it hello_world_sw. Next you will be asked to pick a template design.
The Hello World Small is a software application to write “Hello from Nios II” to the screen. Click
Finish. Note: make sure to pick Hello World Small and NOT “Hello World” or you will not have
enough memory in your FPGA design to store the program executable.
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# Nios Il Application and BSP from Template <@sj-swcf5690-011> O X

Nios Il Software Examples

Create a new application and board support package based on a software example
template

Target hardware information

SOPC Information File name: [fhomeﬂIandis!TEMPfdevkit_hello_worldmios_setup_] E]

CPU name: [niusZe a

Application project

Project name: |peig world_sw

Use default location

Project location:

Project template

Templates Template description
Hello World «] Hello World Small prints *Hello from Nios II' to 2
STDOUT. The project occupies the smallest
Hello World Small memory footprint possible for a hello world
Memory Test application. L

Mernory Test small

This example runs with or without the MicroC/Q5-Il
Simple Socket Server ||| RTOS and requires an STDOUT device in your
system's hardware.

Simple Socket Server (R«

(4]

[ | | | '] Enr details rlick Finish tn create the nrniect and

@ MNext = H Cancel H Finish

Figure 44: completing the Nios Il Software Examples setup screen with project name and project template.

We will now make some modifications to the code to connect the LED[1] to the push button
switch through software. Click the right arrow next to hello_world_sw. It will show the contents of
your project. Double-click hello_world_small.c . Note the command alt_putstr to write text to the
terminal. This is part of the Altera HAL (Hardware Abstraction Layer) set of software functions.
Note that the alt_putstr command is used versus a standard C printf function because the code
space is more compact using the HAL commands. Code using HAL functions without an
operating system is referred to as “bare metal” programming. A complete list of these functions

can be found in the Nios Il Software Developer’'s Handbook
https://www.altera.com/en US/pdfs/literature/hb/nios2/n2sw_nii5v2.pdf .
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#  Nios Il - hello_world_sw/hello_world_small.c - Eclipse <@sj-swcf5690-011>

File Edit Source Refactor Navigate Search Project Nigsll Run Window Help

- S w0l - &

[ Project Explorer 52 l¢ hello_world_small.c 52

= =% hello_world_sw #include "sys/alt_stdio.h"

P il Includes =int main()
P (= system

+ Frhello_world_small.c

|2 create-this-app /* Event loop never exits.

| & Makefile while (1);

readme txt return 0;

P 125 helle_werld_sw_bsp [nios_setup_vZ2] }

e -ip-o-a-®me v -y

&| * "Small Hello World" example. []

alt_putstr("Hello from Nios II!'\n");

*/

TR

] =] [L@Nmsul

]
D)

(@l

5= Outline 2

= O
B %W e
=

ul sys/alt_stdio.h

@ main() . int

Problems i Tasks El Console E Properties 2

Property Value

Writable SmartInsert  2:1

Next you need to add a library declaration, define integer switch_datain, and a few HAL

functions to connect the LEDs to the Push Buttons:

#include <sys/alt_stdio.h>

#include <stdio.h>

#include "altera_avalon_pio_regs.h"
#include "system.h"

int main()

{
int switch_datain;
alt_putstr("Hello from Nios 11"\n");

/* Event loop never exits. Read the PB, display on the LED */

while (1){

switch_datain = IORD_ALTERA_AVALON_PIO_DATA(SWITCH_BASE);
IOWR_ALTERA_AVALON_PIO_DATA(LED_BASE,switch_datain);

}

return 0

¥
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Note the use of the variables SWITCH_BASE and LED BASE. These variables are created by
importing the information from the .sopcinfo file. You can find defined variables in the system.h
file under the hello_world_sw_bsp project. Double click on system.h file and inspect the defined
variable names for SWITCH_BASE and LED_BASE. These must match your
hello_world_small.c code. Edit the hello_world_small.c source code so that it matches the code

L
shown above. Click the save El icon.
Right click on the hello_world_sw project. Left click Build. This compiles the software
application and the BSP (drivers).

©  Nios Il - Eclipse <@sj-swcf5690-011>

File Edit MNavigate Search Project Niosll Run Window Help

B mlOlg -8 d-¢-i%-0-Q-c4 - :
[ouce nccessJ @
[i5 Project Explorer 23 = [ml = 8 o= Outline 82 = 8
=% M M
W_ An outline is not
N 3 available.
beSnel o
Go Into

Open in New Window

5| Copy Ctri+C

¥ Delete Delete
Source G
Rename... F2

£ Import...

3 Export...

Build Project

Clean Project

& | Refresh F5
Close Project isks B Console %8 Properties = 0
Close Unrelated Projects I BBl = Bk | 2B -9 -
. X X hello_world_sw]
Build Configurations FoiniShed (LUUK LZ3s)
Make Targets 4 a
Index L4
T

=% hello w Show in Remote Systems view

Drafilina Thnle .

Figure 45: Launching the build

Once the build completes, you should observe a “.elf” file (executable load file) under the
hello_world_sw project. If the .elf file does not exist, the project did not build properly. Inspect
the problems tab on the bottom of the Eclipse SBT and determine if there are syntax problems,
correct, and rerun Build Project. Typical problems can be missing semicolons, mismatched
brackets and such.
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€  Nios Il - hello_world_sw/hello_world_small.c - Eclipse <

File Edit Source Refactor Navigate Search Project Nig
N R W 0@ & @

[t5 Project Explorer 52 ==
b 4 Binaries
P gl Includes
P = obj
I = system
b [ hello_world_small.c

' [ iﬁhello_world_sw.elf-[alterani052ﬂe] I

|Z| create-this-app

\= hello_world_sw.map

|= hello_world_sw.objdump
| & Makefile

readme txt

I =% hello_world_sw_bsp [nios_setup_v2]

Figure 46: The presence of hello_world_sw.elf indicates the software build ran successfully

MAX10 FPGA Development Kit Cable Connections and Switch Settings

To work with the MAX 10 development kit in the context of this lab, you will need to connect the
power supply to the DC Input and a USB cable connecting the kit to a host PC. It is very
important to note that there are 2 USB connectors: USB Blaster and USB UART. You must
connect the USB cable to the USB Blaster (U12) connector. The USB blaster utilizes circuitry
that formats the image into a data stream that downloads from the PC to FPGA. If you connect
to the USB UART connector, your image will fail to download.

Make sure your development kit is powered up (blue button on kit) and LEDs are on.
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Figure 47: Proper location to connect USB Blaster cable

If you are only performing the Software design lab, you must first launch Quartus. If you have
just performed the Hardware Design lab, then Quartus should already be open.
Launch the Programmer: Tools > Programmer.

Click Auto Detect and you should see something similar to Figure 48.

Make sure the device number selected matches with the device you are working with. Select the
device in the window (Assignments -> Device) as shown below.
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¥ Device <@sj-iccf0131> m -4

Select the family and device you want to target for compilation.
You can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus Prime software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in 'Available devices' list
Eamily: [MAX 10 (DA/DF/DC/SA/SF/SC) ~| || Package: [FEGA =]
Devices: |AII j Pin count: |484 j
Target device Core Speed grade: |Ang.r j
. ) Name filter: |
" Auto device selected by the Fitter
W Sh d d devi
& Specific device selected in 'Available devices' list 0w advanced devices
C Other nf
S Device and Pin Options...‘
Available devices:
Name Core Voltage | LEs | Total I/Os GPIOs Memory Bits | Embedded multiplier g-bitﬂ
10M25DCF48417G L2v 24960 360 360 691200 110
LOM40DAF484CTG Lav 40368 360 360 1290240 250
10M40DAFAB4CEG L2v 40368 360 360 1290240 250
LOM4DDAFABHTG Lav 40368 360 360 1290240 250
10M40DCF4B4CTG L2v 40368 360 360 1290240 250 J
10M40DCF4B4CBG L2v 40368 360 360 1290240 250
10M40DCF4B84I7G L2v 40368 360 1290240

360 250
4] | »
Migration Devices... | 0 migration devices selected

Cancel ‘ Help ‘

" programmer - /home/llandis/TEMP/devkit_hello_world/hello_world_lab - hello_world_lab - [Chain3.cdf]* <@sj-slscf26B0-03>

File Edit View Processing Tools Window Help 57 Search altera.com @

£ Hardware Setup |USB-B\asterH on S)-LLANDIS-530 [USB-1] Mode |JTAG j Progress :

[ Enable real-time ISP to allow background programming when available
Programy/ | Verify ‘ Blank- ISP

o Start File Device Checksum | Usercode
2 Configure Check CLAMP

i stop <none> UNKNOWN_31... 00000000 <none> r r r r r - -
<none> VTAP10 00000000 <none> r r r r r - r

Examine | Security |Erase

Bit

{ Delete
[ Add File.

Change File.

i Save File 1

Add Device - 1
TDI { '
fiup — —
Vi pown
DO

&

1

UNKNOWN_31050DD VTAP10
T
<

Figure 48: Programmer after Auto Detect

Next, you need to download what is called a “.sof” file or SRAM object file. This is the
programming image file that gets downloaded in the FPGA. The default location is
<working_directory>/output_files. Right click on the first row <none> under File and click on
Change File. Navigate to the output_files directory and select hello_world_lab.sof. Click Open.
In the first row under Program/Configure click in the check box as shown in Figure 49.
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<" Programmer - /home/llandis/TEMP/devkit_hello_world/hello_world_lab - hello_world_lab - [Chain3.cdf]* <@sj-slscf2680-03>

File Edit View Processing Tools  Window Help & Search altera.com @

.5, Hardware Setup... | [USB-Blasterll on S}-LLANDIS-530 [USB-1] Mode: [[TAG ~|  Progress :

[™ Enable real-time ISP to allow background programming when available

File Device Checksum | Usercode | Program/ | Verify | Blank- | Examine | Security | Erase ISP

L
P Start Configure Check Bit CLAMP

output_files/hello_... 10M50DAF484... 0037CC92 0037CC92

@i Stop

<nones VTAP10 00000000 <none> r r - - - r -

X Delete

Pl e

(% Add File

&

Change File.

j

[ save File

Add Device IR R

O e -
r i —
Vi Down F i

[V

10M50DAF484E VTAP10

I
|

Figure 49: Programmer after adding hello_world_lab.sof file

Click Start. When programming is complete, the Progress meter should read 100%
(Successful).

% Programmer - /home/llandis/TEMP/devkit_hello_world/hello_world_|ab - hello_world_|ab - [Chain3.cdf]* <@sj-sIscf2680-03>

File Edit View Processing Tools Window Help =l Search altera.com @
£ Hardware Setup...| [USB-Blasterll on 5]-LLANDIS-530 [USB-1] Mode: []TAG =] Progress 100% (Successrul) |
[™ Enable real-time ISP to allew background programming when available
o Start File Device Checksum | Usercode | Program/ | Verify | Blank- [ Examine | Security |Erase ISP
Hl Configure Check Bit CLAMP
) Stop. output_files/hello_... 10M50DAF484... 0037CC92 0037CC92 T r r r r r
<none= VTAP10 00000000 <none> r r r r r r r
ﬁAutu Detect
% Delete
[k Add File
% Change File.
I save File ]
:}Add Device
oI FAITER A PALTERA
fhup — ’ —b '
b pown
10M50DAF484ES VTAP10
. TDO

Figure 50: Programmer after completing .sof download

Now it is time to download the .elf (software executable) into the Nios lle processor. Return to
the Eclipse SBT tools. Right click on hello_world_sw and select Run as > Run Nios I
Hardware. Click on the Target Connection tab. The connection should indicate that Eclipse has
connected to USB-blaster. If the connection is not identified, you can Click Refresh
Connections. Note that you might need to stretch the window wider to see the Refresh
Connections button. Once the connection is made to the USB-Blaster, you should observe
something similar to Figure 51. Click Run.
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¢  Run Configurations <@sj-slscf2680-03> o X

Create, manage, and run configurations
The expected Stdout device name does not match the selected target byte stream device name. @
T
B & - Name Ihe\\oiworldisw Nios Il Hardware configuration I
| ‘ Project | llL Target Connection - %5 Debuggeﬂ =] gommon] B Saurcew
[E] C/C++ Application OGS =
Processors:
[E] c/C++ Remote Application Cable ‘ Device | Device I | Instance D | hlame | Architecture Refresh Connections
# Launch Group USB-ElasterII on S1-LLANDI... [0310500DE1 |1 s} Inios2 o INins2:3
- m Nios Il Hardware System |0 Properties.
v hello_world_sw Nios Il Hardwarjif lEaEElclulis TS5
H N Cable ‘ Device | Device T | Instance D | MName | Version
= Nios |l Hardware v2 (beta) USE-B1asterTl on S1-LLANDI... (0310S0DDEL |1 o [raguart_o |1 L
& Nios Il ModelSim
8 Nios Il ModelSim v2 (beta) [] Disable "Mios Il Cansale’ wiew
«¥ SystemTap Quartus Project File name |< Using default .sopcinfo & jdi files extracted from ELF =
Systern |D checks
D Ignore mismatched system D
Dlgnure mismatched system timestamp L
Download
Download ELF to selected target system = |
(I I I [*)
Filter matched 9 of 9 items
@ Close l [ Bun

Figure 51: Run (Nios Il) Configurations Window in Eclipse.

Now you have hardware and software downloaded into your MAX10 FPGA Development Kit.
You should observe “Hello from Nios II” in the Nios Il Console tab.

3

Nios Il - hello_world_sw2/hello_world.c - Eclipse <@sj-slscf2680-03>

Fle Edit Source Refactor Mavigate Search Project Niosll Run Window Help

o5 - w0 ‘@86 %0 -Q-idE AL DG = | B [@Onos)
[t5 Project Explorer 8| £ & = () [¢ hello_world.c 22 = B £t outline ® = g
e e 8 N
o — * *Hello World" example. i N
D 4 Binaries * = sys/alt_stdioh
b giincludes * This example prints 'Hello from Nigs II' to the STDOUT stream. It runs on o staion
* the Nios II 'standard’, 'full_featured', 'fast’, and 'low_cost' example
P zobj * designs. It runs with or without the MicroC/0S-II RTOS and requires a STDOUT U altera_avalon_pio_regs.h
b [ hello_world.c * device in your system's hardware. o systemh
b * The memory footprint of this hosted application is ~69 Khytes by default
42 nello_world_sw2.elf - [alteranios2/le] * using the standard reference design. = @ main() - int
|2 create-this-app +
2 hell d w2 * For a reduced footprint version of this template, and an explanation of how
5 hello_world_sw2.map * to reduce the memory Tootprint for a given application, see the
2 hello_world_sw2.objdump * *small_hello_world® template.
v
[ Makefile "

readme txt

#include <sys/alt_stdio.h= i

= =% hello_world_sw2_bsp [nios_setup_v2] #includ tdio.h
include <stdio.n>

P @l Includes #include "altera_avalon_pio_regs.h”
b G drivers #include "system.h”
D = HAL “int wain|()
P [g alt_sys_init.c {
- int switch_datain; El
P [ linkerh [I- PR - BT \]H
]
P [W system.h
[2 create-this-bsp . Problems ¥iTasks E Console M Nios Il Console 82 [ Properties = |
linker.x hello_warld_sw2 Nios || Hardware configuration - cable: USE-Blasterll on §-LLANDIS-530 [US8-1] device ID: 1 instance |D: 0 name: jtaguart_0
[ Makefile Hello from Nies II!

L& mem_initmk

[Z/ memory.gdb

(€]

| & public.mk

Figure 52: “Hello from Nios II!” displayed on the Nios Il Console

You can also test the connections between push button and LEDs. Recall that 2 buttons [1:0]
are connected in hardware are inverted so by default the LEDs are on. Buttons [3:2] are
connected in the C code and illuminate LEDs [3:2] when pushed. Refer to the diagram below
and confirm that the push buttons operate the LEDs based on the hello_world.v and
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hello_world.c source files. Be careful not to hit the top and bottom push buttons
PULSE_NCONFIG or FPGA_RESETN or you can disrupt the FPGA programmed status.
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e
.

LED 4 > 0 from left to right

Figure 53: Operating the hello_world lab push buttons

Lab Summary

You now have completed the hardware and software sections of this lab. This includes:
Loading the Device Kit pin settings into Quartus

Using Qsys to build a Nios Il based system

Instantiating the Qsys component into your top level design

Add some connections between push buttons and LEDs

Compiling your hardware

Importing the Nios Il based system into the Eclipse Software Build Tools
Building a software project

Modifying a software template to perform some simple IO functions
Compiling your software

10 Downloading the hardware image into the development kit.

11. Downloading the software executable into the development kit.

12. Testing the hardware

©COoNoUA~WNE

There is a wealth of resources from Altera and partners to take classes on Embedded
Hardware, Embedded Software and reference design starting points to advance your skills
using Altera’s powerful Nios Il based hardware and software tools.
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